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Introduction

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
a product, refer to the Read Me First: Safety and Radio-Frequency
Interference for information about precautions to take.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Ttalic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

NI 5412 Calibration Procedure

This document contains instructions for calibrating the NI 5412 arbitrary
waveform generator. This calibration procedure is intended for metrology
labs. It describes specific programming steps for writing an external
calibration procedure for the NI 5412.
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Refer to ni.com/calibration for additional information about
calibration solutions from National Instruments.

Software and Documentation Requirements

This section describes the software and documentation required for both
self-calibration and external calibration of the NI 5412.

Software

Calibrating the NI 5412 requires installing NI-FGEN version 2.3 or later on
the calibration system. You can download NI-FGEN from the Instrument
Driver Network at ni . com/idnet. NI-FGEN supports programming the
Self-Calibration Procedures and the External Calibration Procedures in
the LabVIEW, LabWindows™/CVI™, and C application development
environments (ADEs). When you install NI-FGEN, you only need to install
support for the ADE that you intend to use.

NI-FGEN 2.3 or later includes all the functions and attributes necessary for
calibrating the NI 5412. For LabWindows/CVI, the NI-FGEN function
panel (niFgen. £p) provides help about the functions available. LabVIEW
support is in the niFgen. 11b file, and all calibration functions appear in
the function palette.

Calibration functions are C function calls or LabVIEW VIs in NI-FGEN.
In this document, the C function call is shown first, followed by the
corresponding LabVIEW VI, or NI-FGEN LabVIEW property node,

in parentheses. The C function calls are valid for any compiler capable of
calling a 32-bit DLL. Many of the functions use constants defined in the
niFgen.h file. To use these constants in C, you must include niFgen.h
in your code when you write the calibration procedure. Refer to Table 1
for file locations.

Table 1. Calibration File Locations

File Name and Location Description

IVI\Bin\niFgen_32.d11 The NI-FGEN library, which provides the
functionality for calibrating the NI 5412.

IVI\Lib\msc\niFgen.lib Allows you to create applications that call

functions in the niFgen_32.d11:

¢ For Microsoft Visual C/C++, link to
msc\niFgen.1lib

* For LabWindows/CVI, link to the library
appropriate to your current compatibility
mode (msc for Microsoft Visual C/C++).

IVI\Lib\bc\niFgen.1lib
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Table 1. Calibration File Locations (Continued)

File Name and Location Description

IVI\Include\niFgen.h A header file for the accessible functions in

the niFgen_32.d11. You must include this
file in any C code that you write to call these
functions.

<LabVIEW>\instr.lib\niFgen\niFgen.1llb | Contains VIs that correspond to the functions

(LabVIEW) in the niFgen_32.d11.
IVI\Drivers\niFgen\niFgen. fp Contains the function panels for the functions
(CVD inniFgen32.d11l.
The calibration process is described in the Self-Calibration Procedures and
the External Calibration Procedures sections, including step-by-step
instructions on calling the appropriate calibration functions.
Documentation

For information about NI-FGEN and the NI 5412, you may find the
following documents helpful:

e NI Signal Generators Getting Started Guide

e NI Signal Generators Help

e NI 5412 Specifications

e NI-FGEN Instrument Driver Quick Reference Guide

The NI Signal Generators Getting Started Guide provides instructions for
installing and configuring NI signal generators.

The NI Signal Generators Help includes detailed information about
the NI 5412 and the NI-FGEN functions. You can access this help file
by selecting Start»Programs»National Instruments»NI-FGEN»
Documentation»NI Signal Generators Help. For the latest versions
of NI documentation, refer to ni . com/manuals.

Self-Calibration Procedures

NI 5412 Calibration Procedure

The NI 5412 is capable of performing self-calibration, which adjusts the
gain and offset of the main analog path. Self-calibration uses only an
onboard ADC to measure the output voltage. You can implement
self-calibration on the NI 5412 by following procedures similar to the
Verifying the DC Gain and Offset Accuracy and the Adjusting the Analog
Output procedures. However, output impedance, oscillator frequency, and
the calibration ADC cannot be adjusted during self-calibration.
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You can initiate self-calibration interactively from Measurement &
Automation Explorer (MAX) or from the FGEN Soft Front Panel (SFP).
Alternnatively, you can initiate self-calibration programmatically using
NI-FGEN.

MAX

To initiate self-calibration from MAX, complete the following steps:
1. Launch MAX.

Select My System»Devices and Interfaces»NI-DAQmx Devices.

2
3. Select the device that you want to calibrate.
4

Initiate self-calibration in one of the following ways:

FGEN Soft Front Panel

Click Self-Calibrate in the upper right corner.

Right-click the device name under Devices and Interfaces,
and select Self-Calibrate from the drop-down menu.

To initiate self-calibration from the FGEN SFP, complete the following

steps:

1. Select the device that you want to calibrate using the Device
Configuration dialog box (Edit»Device Configuration).

2. Open the Calibration dialog box (Utility»Calibration).

Click Perform self-calibration.

NI-FGEN

To self-calibrate the NI 5412 programmatically using NI-FGEN, complete
the following steps:

1. CallniFgen_init (niFgen Initialize VI) to open an NI-FGEN session
using the following parameters:

© National Instruments Corporation

resourceName: The name of the device that you want to calibrate.
You can find this name under Devices and Interfaces in MAX.
IDQuery: VI_TRUE

resetDevice: VI_TRUE

vi: A pointer to a ViSession. The variable passed by reference
through this parameter receives the value that identifies the
session created by this function. This value acts as the session

handle and is passed as the first parameter to all subsequent
NI-FGEN functions.
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2. Call nirgen_sSelfcal (niFgen Self Cal VI) using the following
parameter:

e vi: The session handle returned from niFgen_init

3. CallniFgen_close (niFgen Close VI) to close the NI-FGEN session
using the following parameter:

e vi: The session handle returned from niFgen_init

External Calibration Options

NI 5412 Calibration Procedure

External calibration involves both verification and adjustment. Verification
is the process of testing the device to ensure that the output accuracy is
within certain specifications. You can use verification to ensure that the
adjustment process was successful or to determine if the adjustment
process needs to be performed.

Adjustment is the process of measuring and compensating for device
performance to improve the output accuracy. Performing an adjustment
updates the calibration date, resetting the calibration interval. The device is
guaranteed to meet or exceed its published specifications for the duration
of the calibration interval.

This document provides two sets of test limits for most verification stages,
the calibration test limits and the published specifications. The calibration
test limits are more restrictive than the published specifications. If all of
the output errors determined during verification fall within the calibration
test limits, the device is guaranteed to meet or exceed its published
specifications for a full calibration interval (two years). For this reason,
you must verify against the calibration test limits when performing
verification after adjustment.

If all of the output errors determined during verification fall within the
published specifications, but not within the calibration test limits, the
device meets its published specifications. However, the device may not
remain within these specifications for another two years. The device will
meet published specifications for the rest of the current calibration interval.
In this case, you can perform an adjustment if you want to improve

the output accuracy or reset the calibration interval. If some output

errors determined during verification do not fall within the published
specifications, you must perform an adjustment to restore the device
operation to its published specifications.

The Complete Calibration section describes the recommended
calibration procedure. The Optional Calibration section describes
alternate procedures that allow you to skip adjustment if the device
already meets its calibration test limits or published specifications.
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Complete Calibration

Performing a complete calibration is the recommended way to guarantee
that the NI 5412 meets or exceeds its published specifications for a
two-year calibration interval. At the end of the complete calibration
procedure, you verify that the output error falls within the calibration test
limits. Figure 1 shows the programming flow for complete calibration.

Self-Calibrate
A\
Document
Verify p| Pre-Adjustment
Results
\4
Adjust
(Cal Dates and
Temperatures
Updated)
\4
Document
Verify p| Post-Adjustment
Results

Meets
Calibration
Test Limits?

\4

Review
Verification/
Adjustment

Procedure or
Return Device

Calibration/
Verification
Complete

Figure 1. Complete Calibration Programming Flow
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Optional Calibration

You can choose to skip the adjustment steps of the calibration procedure
if the output error is within the calibration test limits or the published
specifications during the first verification. If all of the output errors
determined during the first verification fall within the calibration test
limits, the device is guaranteed to meet or exceed its published
specifications for a full calibration interval. In this case, you can update
the calibration date, effectively resetting the calibration interval, without
actually performing an adjustment. Refer to the Adjusting the NI 5412
section for more information.

If all of the output errors determined during the first verification fall within
the published specifications, but not within the calibration test limits,
adjustment is also optional. However, you cannot update the calibration
date because the device will not necessarily operate within the published
specifications for an additional two years.

@ Note Regardless of the results of the first verification, if you choose to perform an
adjustment you must verify that the output error falls within the calibration test limits
at the end of the calibration procedure.

NI 5412 Calibration Procedure
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Figure 2 shows the programming flow for the optional calibration.
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Figure 2. Optional Calibration Programming Flow
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External Calibration Requirements

Test Equipment

This section describes the test equipment and test conditions required for
calibration.

External calibration requires different equipment for each applicable
specification. Refer to Table 2 for a list of equipment.

Table 2. Equipment Required for Calibrating the NI 5412

female SMB cable

Applicable Minimum Recommended
Instrument Specification Specifications Instrument
Digital multimeter DC gain and offset | DC accuracy <+50 ppm | NI PXI-4070
(DMM) Resolution <1 pV Agilent HP 34401A
Keithley 2000
Male banana to — —
female BNC adapter
Male BNC to 50 Q, RG-223 —
female SMB cable
Spectrum analyzer or Frequency accuracy | Ability to measure NI PXI-5660
frequency meter lp MHz or higher Agilent HP 8560E
sine waves
Frequency accurac Agilent HP 53131A
R o or HP 53132A
=PV PP with timebase option
001, 010, or 012
Male BNC to 50 Q, RG-223 —

Test Conditions

NI 5412 Calibration Procedure

Follow these guidelines to optimize the connections and the environment
during calibration:

Keep connections to the NI 5412 short.

Keep relative humidity below 80%.

Maintain a temperature between 18 °C and 28 °C.

Observe the 15-minute warm-up time.

10
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External Calibration Procedures

The complete external calibration procedure consists of self-calibrating,
verifying the performance of the NI 5412, adjusting the calibration
constants, and verifying again after the adjustments. In some cases, the
complete calibration procedure may not be required. Refer to the External
Calibration Options section for more information.

The external calibration procedure automatically stores the calibration date
to allow traceability.

Writing the Calibration Procedure

Before you begin to write the calibration program, review the programming
flows in Figures 1 and 2.

Calibration Procedures in LabVIEW

To write calibration procedures in LabVIEW, you must use the
VIs included in the niFgen. 11D file. After installation, these VIs
appear within the NI-FGEN Calibration palette under Functions»
Instrument I/O»Instrument Drivers»NI-FGEN»Calibration.

Calibration Procedures in LabWindows/CVI

To write calibration procedures in LabWindows/CVI, you must use the
functions included in the niFgen. £p file. After installation, you can locate
the calibration functions under the Calibration class node.

Calibration Procedures in C

To write calibration procedures in C, you must include the niFgen.h
file in the code that calls the calibration functions, and you must link
the niFgen. 1ib file into the build of your executable.

© National Instruments Corporation 11 NI 5412 Calibration Procedure



Verifying NI 5412 Specifications

@ Note Always self-calibrate the NI 5412 before beginning a verification procedure.

This section provides instructions for verifying the NI 5412 specifications
and for updating the calibration cycle.

Verification determines whether the device is performing within its
specifications prior to external adjustment. Verification and external
adjustment together comprise a complete calibration. To verify that the
NI 5412 still meets its specifications, you must use NI-FGEN to control
the NI 5412.

The steps in the verification procedures describe the code that you use to
generate the appropriate signals, as well as the NI-FGEN function calls
that you make to verify specifications.

You can verify the following specifications for the NI 5412:
e Oscillator frequency accuracy
e DC gain and offset accuracy

The verification procedure for each of these specifications includes setting
up, programming, and cleaning up.

@ Note If any of these tests fail immediately after you perform an external adjustment, verify
that you have met the required test conditions before you return the NI 5412 to NI for

repair.

NI 5412 Calibration Procedure

Refer to Table 2 for information about which instrument to use for
verifying each specification. Refer to Figure 3 for the names and locations
of the NI PXI-5412 and the NI PCI-5412 front panel connectors.
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NI PXI-5412 NI PCI-5412
14-Bit 100 MS/s AWG

PFIO

PFI1

® 1

Figure 3. NI PXI-5412 and NI PCI-5412 Front Panel Connectors

Verifying the Oscillator Frequency Accuracy

This test verifies the frequency accuracy of the oscillator on the NI 5412.
The verification involves generating a 10 MHz sine wave with the NI 5412

and measuring the sine wave frequency with one of the instruments from
Table 2.

To verify the frequency accuracy of the oscillator on the NI 5412, complete
the following steps:

1. Connect the NI 5412 CH O front panel connector to the instrument

measuring the frequency accuracy with a male BNC to female SMB
cable.

© National Instruments Corporation 13 NI 5412 Calibration Procedure




2. Call niFgen_init (niFgen Initialize VI) using the following
parameters:

* resourceName: The name of the device that you want to verify.
You can find this name under Devices and Interfaces in MAX.

¢ IDQuery: VI_TRUE

* resetDevice: VI_TRUE

e vi: A pointer to a ViSession. The variable passed by reference
through this parameter receives the value that identifies the
session created by this function. This value acts as the session
handle and is passed as the first parameter to all subsequent
NI-FGEN functions.

3. CallniFgen_SetAttributeViReal64 to set the sample rate
(niFgen property node: Arbitrary Waveform Output»Sample Rate)
using the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"

e attributeID: NIFGEN_ATTR_ARB_SAMPLE_RATE

e value: 100000000

4. CallniFgen_SetAttributeViReal64 to set the gain (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Gain) using the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"
e attributeID: NIFGEN_ATTR_ARB_GAIN
e value: 1
@ Note You can adjust the gain value based on which measuring device you use.

5. Call niFgen_SetAttributeViRealé4 to set the offset (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Offset) using the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"
e attributelD: NIFGEN_ATTR_ARB_OFFSET
e value: 0
@ Note You can adjust the offset value based on which measuring device you use.

NI 5412 Calibration Procedure
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Call niFgen_SetAttributevViBoolean to set the digital filter state
(niFgen property node: Output Attributes»Digital Filter Enabled)
using the following parameters:

e vi: The session handle returned from niFgen_init

e channelName: "0"

e attributeID: NIFGEN_ATTR_DIGITAL_FILTER_ENABLED
e value: VI_TRUE

Call niFgen_SetAttributeViReal64 to set the digital filter
interpolation factor (niFgen property node: Qutput Attributes»
Digital Filter Interpolation Factor) using the following parameters:

e vi: The session handle returned from niFgen_init
¢ channelName: "0"

e attributelD:
NIFGEN_ATTR_DIGITAL_FILTER_INTERPOLATION_FACTOR

e value: 4

Generate an array of waveform samples. Each waveform should have
10 samples per cycle with a total of 500 samples and 50 sine wave
cycles. Because you set the sample rate to 100 MS/s and because you
are using 10 samples per cycle, the resulting waveform is a 10 MHz
sine wave.

E Note The sample values of this waveform must fall between —1.0 and 1.0.

9.

Call niFgen_CreateArbWaveform (niFgen Create Arbitrary
Waveform VI) using the following parameters:

e vi: The session handle returned from niFgen_init

*  wfmSize: The size in samples (500) of the waveform you created
in step 8

* wfmData: The array of waveform samples that you created in
step 8

* wfmHandle: The variable passed by reference through this
parameter receives the value (waveform handle) that identifies
the waveform created by this function.

10. CallniFgen_InitiateGeneration (niFgen Initiate Generation VI)

© National Instruments Corporation

to initiate the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init
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11. Measure the frequency out of the NI 5412.

A frequency error of 45 Hz for a 10 MHz signal corresponds to an
error of 4.5 ppm. This limit accounts for the initial accuracy and the
frequency deviation caused by temperature and aging. Refer to Table 3
for frequency ranges.

Table 3. Frequency Ranges

Calibration Test Limit Published Specifications +25 ppm
Low High Low High
9,999,955 Hz 10,000,045 Hz 9,999,750 Hz 10,000,250 Hz

NI 5412 Calibration Procedure

12. Call niFgen_AbortGeneration (niFgen Abort Generation VI) to
abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

13. Call niFgen_close (niFgen Close VI) to close the instrument
driver session, to destroy the instrument driver session and all of
its properties, and to release any memory resources NI-FGEN uses.
Use the following parameter:

e vi: The session handle returned from niFgen_init

Verifying the DC Gain and Offset Accuracy

This test verifies the DC gain and offset accuracy of the NI 5412 into a
high-impedance load by generating a number of DC voltages and offsets,
measuring the voltage with a DMM, and comparing the NI 5412 to the
error limits.

The DC gain and offset accuracy verification procedure has
two sub-procedures that verify the following:

e Main analog path gain
*  Main analog path offset

Verifying the Main Analog Path Gain

To verify the gain of the NI 5412 main analog path, complete the following
steps:

1. Connect the NI 5412 CH 0 front panel connector to the DMM for
measuring DC gain and offset accuracy.

2. Call niFgen_init (niFgen Initialize VI) using the following
parameters:

* resourceName: The name of the device that you want to verify.
You can find this name under Devices and Interfaces in MAX.

16 ni.com
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e IDQuery: VI_TRUE
e resetDevice: VI_TRUE

* vi: A pointer to a ViSession. The variable passed by reference
through this parameter receives the value that identifies the
session created by this function. This value acts as the session
handle and is passed as the first parameter to all subsequent
NI-FGEN functions.

Call niFgen_SetAttributeViRealé64 to set the load impedance
(niFgen property node: Output Attributes»Load Impedance)
using the following parameters:

e vi: The session handle returned from niFgen_init
* channelName: "0"

e attributelD: NTFGEN_ATTR_LOAD_IMPEDANCE

. value: 10000000000

CallniFgen_SetAttributeviInt32 to setthe analog path (niFgen
property node: Output Attributes»Analog Path) using the following
parameters:

e vi: The session handle returned from niFgen_init
¢ channelName: "0"

e attributelD: NIFGEN_ATTR_ANALOG_PATH

e value: NIFGEN_VAL_MAIN_ANALOG_PATH

Call niFgen_SetAttributeViRealé4 to set the output impedance
(niFgen property node: Basic Operation»Output Impedance) using
the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_IMPEDANCE
e value: 50

CallniFgen_SetAttributevViBoolean to enable the analog output
(niFgen property node: Basic Operation»QOutput Enabled) using
the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_TRUE

Create an array of waveform samples for the positive full-scale DC
waveform. This array should contain 500 samples with each sample
having the value 1.0 (representation: double).
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8. Call niFgen_CreateArbWaveform (niFgen Create Arbitrary
Waveform VI) using the following parameters:

e vi: The session handle returned from niFgen_init

e wfmSize: The size in samples (500) of the waveform you created
in step 7

¢ wfmData: The array of waveform samples that you created in
step 7

¢ wifmHandle: The variable passed by reference through this
parameter receives the value (waveform handle) that identifies the
waveform created by this function (positive full-scale handle).

9. Create an array of waveform samples for the negative full-scale DC
waveform. This array should contain 500 samples with each sample
having the value -1 . 0 (representation: double).

10. Call niFgen_CreateArbWaveform (niFgen Create Arbitrary
Waveform VI) using the following parameters:

e vi: The session handle returned from niFgen_init

e wfmSize: The size in samples (500) of the waveform that you
created in step 9

e wfmData: The array of waveform samples that you created in
step 9

¢ wifmHandle: The variable passed by reference through this
parameter receives the value (waveform handle) that identifies the
waveform created by this function (negative full-scale handle).

11. Call niFgen_SetAttributeViRealé4 to set the offset (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Offset) using the following parameters:

e vi: The session handle returned from niFgen_init
¢ channelName: "0"
e attributelD: NIFGEN_ATTR_ARB_OFFSET

e value: 0

NI 5412 Calibration Procedure 18 ni.com



Repeat steps 12 through 22 for each of the 24 iterations listed in Table 4,
changing the Gain value for each iteration.

Table 4. Values for Verifying the Gain of the Main Analog Path

Ideal Positive Ideal Negative
Full-Scale Full-Scale Calibration Test Published Spec
Iteration Gain (Volts) (Volts) Limit (Volts) (Volts)

1 12.000000 12.000000 —12.000000 +0.019700 +0.048500
2 10.000000 10.000000 —10.000000 +0.016500 +0.040500
3 7.000000 7.000000 —7.000000 +0.011700 +0.028500
4 5.000000 5.000000 —5.000000 +0.008500 +0.020500
5 3.500000 3.500000 —3.500000 +0.006100 +0.014500
6 2.500000 2.500000 —2.500000 +0.004500 +0.010500
7 2.000000 2.000000 —2.000000 +0.003700 +0.008500
8 1.650000 1.650000 —-1.650000 +0.003140 +0.007100
9 1.250000 1.250000 —-1.250000 +0.002500 +0.005500
10 0.850000 0.850000 —0.850000 +0.001860 +0.003900
11 0.600000 0.600000 —0.600000 +0.001460 +0.002900
12 0.415000 0.415000 —0.415000 +0.001164 +0.002160
13 0.300000 0.300000 —0.300000 +0.000980 +0.001700
14 0.205000 0.205000 —0.205000 +0.000828 +0.001320
15 0.150000 0.150000 —0.150000 +0.000740 +0.001100
16 0.105000 0.105000 —0.105000 +0.000668 +0.000920
17 0.075000 0.075000 —-0.075000 +0.000620 +0.000800
18 0.055000 0.055000 —-0.055000 +0.000588 +0.000720
19 0.037500 0.037500 —-0.037500 +0.000560 +0.000650
20 0.026000 0.026000 —-0.026000 +0.000542 +0.000604
21 0.018500 0.018500 —0.018500 +0.000530 +0.000574
22 0.013000 0.013000 —0.013000 +0.000521 +0.000552
23 0.009000 0.009000 —0.009000 +0.000514 +0.000536
24 0.006500 0.006500 —0.006500 +0.000510 +0.000526

Error Positive Full-Scale Value = (Measured Positive Full-Scale Value) — (Ideal Positive Full-Scale Value)
Error Negative Full-Scale Value = (Measured Negative Full-Scale Value) — (Ideal Negative Full-Scale Value)

© National Instruments Corporation
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12.

13.

14.

15.

16.

Call niFgen_SetAttributeViReal64 to set the gain (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Gain) using the following parameters:

e vi: The session handle returned from niFgen_init

¢ channelName: "0"

e attributelD: NIFGEN_ATTR_ARB_GAIN

e value: The Gain value listed in Table 4 for the current iteration

Call niFgen_SetAttributeViInt32 to choose the positive
full-scale DC waveform (niFgen property node: Arbitrary
Waveform Output»Arbitrary Waveform Handle) using
the following parameters:

e vi: The session handle returned from niFgen_init

e channelName: "0"

e attributeID: NIFGEN_ATTR_ARB_WAVEFORM_ HANDLE

e value: The wfmHandle from step 8 (positive full-scale handle)

CallniFgen_InitiateGeneration (niFgen Initiate Generation VI)
to initiate the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

Measure the DC voltage out of the NI 5412. This is the Measured
Positive Full-Scale Value.

Determine the error for positive full-scale using the following formula:

Error Positive Full-Scale =

(Measured Positive Full-Scale Value) — (Ideal Positive Full-Scale Value)

17.

18.

19.

Compare this error to the Published Spec or the Calibration Test Limit.

Call niFgen_aAbortGeneration (niFgen Abort Generation VI) to
abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

Call niFgen_SetAttributeViInt32 to choose the negative
full-scale DC waveform (niFgen property node: Arbitrary
Waveform Output»Arbitrary Waveform Handle) using the
following parameters:

e vi: The session handle returned from niFgen_init

e channelName: "0"

e attributeID: NIFGEN_ATTR_ARB_WAVEFORM_ HANDLE

e value: The wfmHandle from step 10 (negative full-scale handle)

CallniFgen_InitiateGeneration (niFgen Initiate Generation VI)
to initiate the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init
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20.

21.

22.

23.

Measure the DC voltage out of the NI 5412. This is the Measured
Negative Full-Scale Value.

Calculate the error for negative full-scale using the following formula:

Error Negative Full-Scale =
(Measured Negative Full-Scale Value) — (Ideal Full-Scale Value)

Compare this error to the Published Spec or the Calibration Test Limit.

Call niFgen_aAbortGeneration (niFgen Abort Generation VI) to
abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

If any of the errors are greater than the Calibration Test Limit, perform
an external adjustment.

Verifying the Main Analog Path Offset

To verify the offset of the NI 5412 main analog path, complete the
following steps:

1.

© National Instruments Corporation

Create an array of waveform samples for the mid-scale DC waveform
(0 VDC). This array should contain 500 samples with each sample
having the value 0.0 (representation: double).

Call niFgen_CreateArbWaveform (niFgen Create Arbitrary
Waveform VI) using the following parameters:

e vi: The session handle returned from niFgen_init

»  wfmSize: The size in samples (500) of the waveform that you
created in step 1

* wfmData: The array of waveform samples that you created in
step 1

*  wfmHandle: The variable passed by reference through this
parameter receives the value (waveform handle) that identifies
the waveform created by this function (mid-scale handle).

Call niFgen_SetAttributeviInt32 to choose the mid-scale
handle DC waveform (niFgen property node: Arbitrary Waveform
Output»Arbitrary Waveform Handle) using the following
parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"
e attributeID: NIFGEN_ATTR_ARB_WAVEFORM_HANDLE

* value: The wfmHandle from step 2 (mid-scale handle)
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Repeat steps 4 through 14 for each of the 24 iterations listed in Table 5,
changing the Ideal Positive Offset, Ideal Negative Offset, and Gain values
for each iteration.

Table 5. Values for Verifying the Offset of the Main Analog Path

Ideal Negative Calibration Test
Ideal Positive Offset Limit Published Spec
Iteration Gain Offset (Volts) (Volts) (Volts) (Volts)
1 12.000000 6.000000 —6.000000 +0.021500 +0.051500
2 10.000000 5.000000 —5.000000 +0.018000 +0.043000
3 7.000000 3.500000 —3.500000 +0.012750 +0.030250
4 5.000000 2.500000 —2.500000 +0.009250 +0.021750
5 3.500000 1.750000 -1.750000 +0.006625 +0.015375
6 2.500000 1.250000 -1.250000 +0.004875 +0.011125
7 2.000000 1.000000 —-1.000000 +0.004000 +0.009000
8 1.650000 0.825000 —0.825000 +0.003388 +0.007513
9 1.250000 0.625000 —-0.625000 +0.002688 +0.005813
10 0.850000 0.425000 —0.425000 +0.001988 +0.004113
11 0.600000 0.300000 —0.300000 +0.001550 +0.003050
12 0.415000 0.207500 —-0.207500 +0.001226 +0.002264
13 0.300000 0.150000 —0.150000 +0.001025 +0.001775
14 0.205000 0.102500 —0.102500 +0.000859 +0.001371
15 0.150000 0.075000 —-0.075000 +0.000763 +0.001138
16 0.105000 0.052500 —-0.052500 +0.000684 +0.000946
17 0.075000 0.037500 —-0.037500 +0.000631 +0.000819
18 0.055000 0.027500 —-0.027500 +0.000596 +0.000734
19 0.037500 0.018750 —-0.018750 +0.000566 +0.000659
20 0.026000 0.013000 —0.013000 +0.000546 +0.000611
21 0.018500 0.009250 —0.009250 +0.000532 +0.000579
22 0.013000 0.006500 —0.006500 +0.000523 +0.000555
23 0.009000 0.004500 —0.004500 +0.000516 +0.000538
24 0.006500 0.003250 —-0.003250 +0.000511 +0.000528
Error Positive Offset Value = (Measured Positive Offset Value) — (Ideal Positive Offset Value)
Error Negative Offset Value = (Measured Negative Offset Value) — (Ideal Negative Offset Value)
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4. CallniFgen_SetAttributeViRealé64 to set the offset (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Offset) using the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"
e attributeID: NIFGEN_ATTR_ARB_OFFSET

* value: The Ideal Positive Offset value listed in Table 5 for the
current iteration

5. CallniFgen_SetAttributeViReal64 to set the gain (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Gain) using the following parameters:

e vi: The session handle returned from niFgen_init

* channelName: "0"

e attributeID: NTFGEN_ATTR_ARB_GAIN

e value: The Gain value listed in Table 5 for the current iteration

6. CallniFgen_InitiateGeneration (niFgen Initiate Generation VI)
to initiate the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

7. Measure the positive DC voltage out of the NI 5412. This is the
Measured Positive Offset Value.

8. Calculate the error for positive offset using the following formula:

Error Positive Offset =
(Measured Positive Offset Value) — (Ideal Positive Offset Value)

Compare this error to the Published Spec or the Calibration Test Limit.

9. Call niFgen_AbortGeneration (niFgen Abort Generation VI) to
abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

10. Call niFgen_SetAttributeViReal64 to set the offset (niFgen
property node: Arbitrary Waveform Output»Arbitrary
Waveform Offset) using the following parameters:

e vi: The session handle returned from niFgen_init
e channelName: "0"
e attributeID: NIFGEN_ATTR_ARB_OFFSET

* value: The Ideal Negative Offset value listed in Table 5 for the
current iteration
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11. CallniFgen_InitiateGeneration (niFgen Initiate Generation VI)
to initiate the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

12. Measure the negative DC voltage out of the NI 5412. This is the
Measured Negative Offset Value.

13. Calculate the error for positive offset using the following formula:

Error Negative Offset =
(Measured Negative Offset Value) — (Ideal Negative Offset Value)

Compare this error to the Published Spec or the Calibration Test Limit.

14. Call niFgen_aAbortGeneration (niFgen Abort Generation VI) to
abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_init

15. If any of the errors are greater than the Calibration Test Limit, perform
an external adjustment.

Adjusting the NI 5412

NI 5412 Calibration Procedure

If the NI 5412 successfully passes all verification within the calibration
test limits, adjustment is recommended, but not required, to guarantee its
published specifications for the next two years. If the NI 5412 was not
within the calibration test limits for each verification procedure, perform
the adjustment procedure to improve the accuracy of the NI 5412. Refer
to the External Calibration Options section to determine which procedures
to perform.

An adjustment is required only once every two years. The adjustment
procedure automatically updates the calibration date and temperature in
the EEPROM of the NI 5412.

If the NI 5412 passed verification within the calibration test limits and
you do not want to do an adjustment, you can update the calibration date
and onboard calibration temperature without making any adjustments by
completing the following steps:

1. Call niFgen_InitExtCal (niFgen Init Ext Cal VI) to open an
NI-FGEN external calibration session using the following parameters:

¢ resourceName: The name of the device you want to calibrate.
You can find this name under Devices and Interfaces in MAX.

e password: The password required to open an external
calibration session. If this password has not been changed
since manufacturing, the password is "NATI".
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e vi: A pointer to a ViSession. The variable passed by reference
through this parameter receives the value that identifies the
external calibration session created by this function. This value
acts as the session handle and is passed as the first parameter to
all subsequent NI-FGEN functions.

2. CallniFgen_CloseExtCal (niFgen Close Ext Cal VI) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal

* action: NIFGEN_VAL_EXT_CAL_COMMIT

The external calibration procedure adjusts the analog output, the oscillator
frequency, and the calibration ADC. Analog output adjustment
characterizes the DC gains and the offsets of the analog path to ensure
the analog output voltage accuracy. Adjusting the oscillator frequency
adjusts the onboard oscillator to ensure frequency accuracy. Calibration
ADC adjustment characterizes the onboard ADC gain and offset so that
self-calibration results in an accurately calibrated device.

You cannot perform an external calibration using a standard NI-FGEN
session. You must create an external calibration session using
niFgen_InitExtCal (niFgen Init Ext Cal VI). An external calibration
session allows you to use NI-FGEN functions and attributes that are
specifically for external calibration, while still allowing you to use all

the standard NI-FGEN functions and attributes with the external calibration
session.

Along with the standard NI-FGEN attributes, the external calibration
session uses a set of calibration constants that are determined during the
calibration procedure and stored in the device onboard memory when
the session is closed. NI-FGEN uses these calibration constants during

a standard NI-FGEN session to ensure that the device operates within its
specifications.

You must close an external calibration session by using
niFgen_CloseExtCal (niFgen Close Ext Cal VI).

Figure 4 shows the programming flow for an external calibration
procedure.
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Initialize Ext Cal Session

v

Initialize Analog Output Calibration

v

Adjust Main Path Pre-Amp Offset

v

Adjust Main Path Pre-Amp Gain

v

Adjust Main Path Post-Amp
Gain and Offset

v

Initialize Oscillator
Frequency Calibration

v

Adjust Oscillator Frequency

v

Initialize Calibration
ADC Calibration

v

Adjust Calibration ADC

v

Close Ext Cal Session

Figure 4. NI 5412 External Calibration Procedure

Initializing the External Calibration Session

Call niFgen_InitExtCal (niFgen Init Ext Cal VI) to open an NI-FGEN
external calibration session using the following parameters:

e resourceName: The name of the device you want to calibrate.
This name can be found under Devices and Interfaces in MAX.

e password: The password required to open an external calibration
session. If this password has not been changed since manufacturing,
the password is "NATI".

e vi: A pointer to a ViSession. The variable passed by reference through
this parameter receives the value that identifies the external calibration
session created by this function. This value acts as the session handle
and is passed as the first parameter to all subsequent NI-FGEN
functions.
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Adjusting the Analog Output

The analog output adjustment procedure has several sub-procedures that
adjust the following:

*  Main path pre-amplifier offset
*  Main path pre-amplifier gain
*  Main path post-amplifier gain and offset

In each of these sub-procedures, you put the device in several
configurations and take several output measurements. You then pass
these measurements to NI-FGEN, which determines the calibration
constants for the device.

Initializing Analog Output Calibration

1. CallniFgen_InitializeAnalogOutputCalibration (niFgen
Initialize Analog Output Calibration VI) using the following
parameter:

e vi: The session handle returned from niFgen_InitExtCal

2. CallniFgen_WriteBinarylé6AnalogStaticvalue (niFgen Write
Binary 16 Analog Static Value VI) to set the main DAC value using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"
e value: 0

3. Call niFgen_SetAttributeviInt32 to set the analog path value
(niFgen property node: Output Attributes»Analog Path) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributelD: NTFGEN_ATTR_ANALOG_PATH

e value: NIFGEN_VAL_FIXED_LOW_GAIN_ANALOG_PATH

4. CallniFgen_SetAttributeviInt32 to set the gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NTIFGEN_ATTR_GAIN_DAC_VALUE

e value: 2000
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10.

Call niFgen_SetAttributeviInt32 to set the offset DAC value
(niFgen property node: Calibration»Offset DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OFFSET_DAC_VALUE

e value: 32767

Call niFgen_SetAttributeViReal64 to set the pre-amplifier
attenuation (niFgen property node: Calibration»Pre-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

¢ channelName: "0"

e attributeID: NIFGEN_ATTR_PRE_AMPLIFIER_ATTENUATION
e value: 0

Call niFgen_SetAttributeViRealé64 to set the post-amplifier
attenuation (niFgen property node: Calibration»Post-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

¢ channelName: "0"

e attributeID: NIFGEN_ATTR_POST_AMPLIFIER_ATTENUATION
e value: 0

Call niFgen_SetAttributeViReal64 to set the output impedance
(niFgen property node: Basic Operation»>Output Impedance) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributeID: NTFGEN_ATTR_OUTPUT_IMPEDANCE

e value: 50

Call niFgen_SetAttributeViBoolean to enable the analog output
(niFgen property node: Basic Operation»Output Enabled) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_TRUE

Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
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Adjusting the Main Path Pre-Amplifier Offset

1.

Call niFgen_SetAttributeviInt32 to set the analog path value
(niFgen property node: Output Attributes»Analog Path) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
* channelName: "0"

e attributeID: NIFGEN_ATTR_ANALOG_PATH

e value: NIFGEN_VAL_FIXED_LOW_GAIN_ANALOG_PATH

Call niFgen_SetAttributeViRealé64 to set the post-amplifier
attenuation (niFgen property node: Calibration»Post-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

¢ channelName: "0"

e attributeID: NIFGEN_ATTR_POST_AMPLIFIER_ATTENUATION
e value: 0

Call niFgen_WriteBinaryl6AnalogStaticvalue (niFgen Write
Binary 16 Analog Static Value VI) to set the main DAC value using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e value: 0

Repeat steps 4 through 6 for each of the 5 iterations listed in Table 6,
changing the Pre-Amplifier Attenuation and Current Configuration values
for each iteration.

Table 6. Attributes and Values for Main Path Pre-Amplifier Offset

Pre-Amplifier

Iteration Attenuation Current Configuration
1 0 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_0DB
2 3 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_3DB
3 6 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH FILTER_OFF_6DB
4 9 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_9DB
5 12 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_12DB
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4. CallniFgen_SetAttributeViReal64 to set the pre-amplifier
attenuation (niFgen property node: Calibration»Pre-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"
e attributeID: NIFGEN_ATTR_PRE_AMPLIFIER_ATTENUATION

e value: The Pre-Amplifier Attenuation value for the current
iteration from Table 6

5. Take the following voltage measurements at the NI 5412 CH 0 front
panel connector into a high-impedance load:

a. CallniFgen_SetAttributeviInt32 tosetthe gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributelD: NTFGEN_ATTR_GAIN_DAC_VALUE

e value: 2000

b. Call niFgen_SetAttributeviInt32 to set the offset DAC
value (niFgen property node: Calibration»Offset DAC Value)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributeID: NTFGEN_ATTR_OFFSET_DAC_VALUE

e value: 50000

c. Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
d.  Wait 500 ms for the output to settle.

e. Use the DMM to measure the voltage output by the device. This
measurement is measurement 0, which is used in step 6.

f. CallniFgen_SetAttributeViInt32 tosetthe gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributelD: NTFGEN_ATTR_GAIN_DAC_VALUE

e value: 1000
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Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the voltage output by the device. This
measurement is measurement 1, which is used in step 6.

Call niFgen_SetAttributeviInt32 to set the offset DAC
value (niFgen property node: Calibration»Offset DAC Value)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributeID: NIFGEN_ATTR_OFFSET_DAC_VALUE

e value: 15000

Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the voltage output of the device. This
measurement is measurement 2, which is used in step 6.

6. CallniFgen_CalAdjustMainPathPreAmpOffset (niFgen Cal
Adjust Main Path Pre Amp Offset VI) using the following parameters:
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vi: The session handle returned from niFgen_InitExtCal
channelName: "0"

configuration: The Current Configuration value for the current
iteration from Table 6

gainDACValues: An array containing two elements—the two
values (2000, 1000) that you set as the gain DAC in the order that
you measured them

offsetDACValues: An array containing two elements—the two
values (50000, 15000) that you set as the offset DAC in the order
that you measured them

measuredOutputs: An array containing three elements—the
three output voltages (measurement 0, measurement 1,
measurement 2) that you measured in the order that you
measured them
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Adjusting the Main Path Pre-Amplifier Gain

1. Call niFgen_SetAttributeViInt32 to set the analog path value
(niFgen property node: Output Attributes»Analog Path) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_ANALOG_PATH

¢ value: NIFGEN_VAL_FIXED_LOW_GAIN_ANALOG_PATH

2. CallniFgen_SetAttributeViRealé64 to set the post-amplifier
attenuation (niFgen property node: Calibration»Post-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

¢ channelName: "0"

e attributeID: NIFGEN_ATTR_POST_AMPLIFIER_ATTENUATION
e value: 0

3. Call niFgen_SetAttributeviInt32 to set the offset DAC value
(niFgen property node: Calibration»Offset DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributelD: NIFGEN_ATTR_OFFSET_DAC_VALUE

e value: 32000

Repeat steps 4 through 6 for each of the 5 iterations listed in Table 7,
changing the Pre-Amplifier Attenuation and Current Configuration values
for each iteration.

Table 7. Attributes and Values for Main Path Pre-Amplifier Gain

Pre-Amplifier
Iteration Attenuation Current Configuration
1 0 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_O0ODB
2 3 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_3DB
3 6 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_6DB
4 9 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_O9DB
5 12 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_FILTER_OFF_12DB
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Call niFgen_SetAttributeViReal64 to set the pre-amplifier
attenuation (niFgen property node: Calibration»Pre-Amplifier
Attenuation) using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0
attributeID: NIFGEN_ATTR_PRE_AMPLIFIER_ATTENUATION

value: The Pre-Amplifier Attenuation value for the current
iteration from Table 7

Take the following voltage measurements at the NI 5412 CH O front
panel connector into a high-impedance load:

a.

CallniFgen_SetAttributeviInt32 to setthe gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
* channelName: "0"

e attributeID: NIFGEN_ATTR_GAIN_DAC_VALUE

e value: 1500

Call niFgen_WriteBinaryl6AnalogStaticvalue (niFgen
Write Binary 16 Analog Static Value VI) to set the main DAC
value using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"
e value: 25233

Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the voltage output by the device. This
measurement is measurement 0, which is used in step 6.

CallniFgen_SetAttributevilInt32 to setthe gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributeID: NTIFGEN_ATTR_GAIN_DAC_VALUE

e value: 2000
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Call niFgen_WriteBinaryl6AnalogStaticValue (niFgen
Write Binary 16 Analog Static Value VI) to set the main DAC
value using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"
e value: —29232

Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the voltage output by the device. This
measurement is measurement 1, which is used in step 6.

Call niFgen_CalAdjustMainPathPreAmpGain (niFgen Cal
Adjust Main Path Pre Amp Gain VI) using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"

configuration: The Current Configuration value for the current
iteration from Table 7

mainDA CValues: An array containing two elements—the two
values (25233, —29232) that you set for the main DAC in the
order that you measured them

gainDA CValues: An array containing two elements—the two
values (1500, 2000) that you set for the gain DAC in the order
that you measured them

offsetDACValues: An array containing one element—the value
(32000) that you set for the offset DAC

measuredOutputs: An array containing two elements—the
two output voltages (measurement 0, measurement 1) that
you measured in the order that you measured them
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Adjusting the Main Path Post-Amplifier Gain and Offset

1. CallniFgen_WriteBinaryl6AnalogStaticvValue (niFgen Write
Binary 16 Analog Static Value VI) to set the main DAC value using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"
e value: 0

2. CallniFgen_SetAttributeViReal64 to set the pre-amplifier
attenuation (niFgen property node: Calibration»Pre-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

e channelName: "0"

e attributeID: NIFGEN_ATTR_PRE_AMPLIFIER_ATTENUATION
e value: 0

3. Call niFgen_SetAttributeviInt32 to set the gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
* channelName: "0"

e attributeID: NIFGEN_ATTR_GAIN_DAC_VALUE

e value: 2000
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Repeat steps 4 through 7 for each of the eight iterations listed in Table 8,
changing the Post-Amplifier Attenuation and Current Configuration values
for each iteration.

Table 8. Attributes and Values for the Main Path Post-Amplifier Gain and Offset

Post-Amp
Iteration Analog Path Attenuation Current Configuration

1 NIFGEN_VAL_FIXED_LOW_GAIN_ 0 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH LOW_GAIN_0DB

2 NIFGEN_VAL_FIXED_LOW_GAIN_ 12 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH LOW_GAIN_12DB

3 NIFGEN_VAL_FIXED_LOW_GAIN_ 24 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH LOW_GAIN_24DB

4 NIFGEN_VAL_FIXED_LOW_GAIN_ 36 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH LOW_GAIN_36DB

5 NIFGEN_VAL_FIXED HIGH GAIN_ 0 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH HIGH_GAIN_ODB

6 NIFGEN_VAL_FIXED_HIGH_GAIN_ 12 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH HIGH_GAIN_12DB

7 NIFGEN_VAL_FIXED HIGH GAIN_ 24 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH HIGH_GAIN_24DB

8 NIFGEN_VAL_FIXED_HIGH_GAIN_ 36 NIFGEN_VAL_CAL_CONFIG_MAIN_PATH_
ANALOG_PATH HIGH_GAIN_36DB
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Call niFgen_SetAttributeViInt32 to set the analog path value
(niFgen property node: Output Attributes»Analog Path) using
the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"
attributelD: NIFGEN_ATTR_ANALOG_PATH

value: The Analog Path value for the current iteration from
Table 8

Call niFgen_SetAttributeViRealé64 to set the post-amplifier
attenuation (niFgen property node: Calibration»Post-Amplifier
Attenuation) using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"
attributeID: NIFGEN_ATTR_POST_AMPLIFIER_ATTENUATION

value: The Post-Amplifier Attenuation value for the current
iteration from Table 8
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6. Take the following voltage measurements at the NI 5412 CH O front
panel connector into a high-impedance load:

© National Instruments Corporation

a.

Call niFgen_SetAttributeviInt32 to set the offset DAC
value (niFgen property node: Calibration»Offset DAC Value)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OFFSET_DAC_VALUE

e value: 50000

Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the voltage output by the device.
This measurement is measurement 0, which is used in step 7.

Call niFgen_SetAttributeviInt32 to set the offset DAC
value (niFgen property node: Calibration»Offset DAC Value)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributeID: NIFGEN_ATTR_OFFSET_DAC_VALUE

e value: 15000

Call niFgen_Commit (niFgen Commit VI) to commit the
attribute values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the voltage output by the device.
This measurement is measurement 1, which is used in step 7.
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7. Call niFgen_cCalAdjustMainPathPostAmpGainAndOffset
(niFgen Cal Adjust Main Path Post Amp Gain And Offset VI)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e configuration: The Current Configuration value for the current
iteration from Table 8

« mainDACValues: An array containing two elements—the values
(0, 0) that you set on the main DAC

e gainDACValues: An array containing one element—the value
(2000) that you set on the gain DAC

* offsetDACValues: An array containing two elements—the two
values (50000, 15000) that you set on the offset DAC in order

¢ measuredOutputs: An array containing two elements—the
two output voltages (measurement 0, measurement 1) that
you measured in order

Adjusting the Oscillator Frequency

Adjusting the oscillator frequency involves generating a sine wave at a
desired frequency, and then iteratively measuring the frequency, passing
the measured value to NI-FGEN so that the oscillator can be adjusted, and
then re-measuring the resulting frequency. This process is repeated until
the difference between the desired and measured frequency falls within the
desired tolerance 4.5 ppm. This adjustment ensures the frequency accuracy
of the onboard oscillator.

1. Call niFgen_InitializeOscillatorFrequencyCalibration
(niFgen Initialize Oscillator Frequency Calibration VI) using the
following parameter:

e vi: The session handle returned from niFgen_InitExtCal

2. CallniFgen_SetAttributeViReal64 to set the sample rate
(niFgen property node: Arbitrary Waveform Output»Sample Rate)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_ARB_SAMPLE_RATE

e value: 100000000
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3.

Call niFgen_SetAttributeViReal64 to set the gain (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Gain) using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"

attributeID: NTFGEN_ATTR_ARB_GAIN

value: 1

@ Note You can adjust this value based on which measuring device you use.

4. CallniFgen_SetAttributeViRealé64 to set the offset (niFgen
property node: Arbitrary Waveform Output»Arbitrary Waveform
Offset) using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"
attributelD: NIFGEN_ATTR_ARB_OFFSET

value: 0

E Note You can adjust this value based on which measuring device you use.
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CallniFgen_SetAttributeViBoolean to set the digital filter state
(niFgen property node: Output Attributes»Digital Filter Enabled)
using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0
attributelD: NIFGEN_ATTR_DIGITAL_FILTER_ENABLED

value: VI_TRUE

Call niFgen_SetAttributeViReal64 to set the digital filter
interpolation factor (niFgen property node: Output Attributes»
Digital Filter Interpolation Factor) using the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"

attributelD:
NIFGEN_ATTR_DIGITAL_FILTER_ INTERPOLATION_FACTOR

value: 4

Call niFgen_SetAttributeViReal64 to set the output impedance
(niFgen property node: Basic Operation»Output Impedance) using
the following parameters:

vi: The session handle returned from niFgen_InitExtCal
channelName: "0"
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10.

1.

12.

13.

e attributeID: NIFGEN_ATTR_OUTPUT_IMPEDANCE
e value: 50

Call niFgen_SetAttributeViBoolean to enable the analog output
(niFgen property node: Basic Operation»Output Enabled) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_TRUE

Generate an array of waveform samples.

Each waveform should have 10 samples per cycle, with a total of
500 samples and 50 sine wave cycles. Because you set the sample rate
to 100 MS/s and because there are 10 samples per cycle, the resulting
waveform is a 10 MHz sine wave. The sample values of this waveform
must fall between —1.0 and 1.0.

Call niFgen_CreateArbWaveform (niFgen Create Arbitrary
Waveform VI) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

e wfmSize: The size in samples (500) of the waveform you created
in step 9

¢ wfmData: The array of waveform samples that you created in
step 9

¢ wifmHandle: The variable passed by reference through this
parameter receives the value (waveform handle) that identifies
the waveform created by this function

CallniFgen_InitiateGeneration (niFgen Initiate Generation VI)
to initiate the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal

Measure the frequency of the generated waveform. This value is the
measured fregquency, which is used in step 13.

Repeat steps 13a through 13d for as long as the difference between the
measured frequency and the desired frequency (10 MHz) is greater
than the tolerance (4.5 ppm).

The measured frequency should converge on the desired frequency.
If the measured frequency does not converge on the desired frequency
within 16 iterations, a problem may exist with your measurement
device or the NI 5412.

a. CallniFgen_aAbortGeneration (niFgen Abort Generation VI)
to abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
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b. CallniFgen_CalAdjustOscillatorFrequency (niFgen Cal
Adjust Oscillator Frequency VI) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

* desiredFrequencyInHz: The desired frequency (10000000)
of the generated sinusoid in Hz

*  measuredFrequencyInHz: The measured frequency of
the generated sinusoid in Hz

c. CallniFgen_ InitiateGeneration (niFgen Initiate
Generation VI) to initiate the waveform generation using
the following parameter:

e vi: The session handle returned from niFgen_InitExtCal

d. Measure the frequency of the generated waveform. This value is
the measured frequency.

14. Call niFgen_AbortGeneration (niFgen Abort Generation VI) to
abort the waveform generation using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal

Adjusting the Calibration ADC

The NI 5412 has an onboard calibration ADC that is used during
self-calibration. Adjusting the calibration ADC involves characterizing the
gain and offset associated with this ADC so that performing self-calibration
results in an accurately calibrated device.

1. CallniFgen_InitializeCalADCCalibration (niFgen Initialize
Cal ADC Calibration VI) using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal

2. CallniFgen_WriteBinarylé6AnalogStaticvalue (niFgen Write
Binary 16 Analog Static Value VI) to set the main DAC value using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"
e value: 0

3. Call niFgen_SetAttributeviInt3?2 to set the analog path value
(niFgen property node: Output Attributes»Analog Path) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"
e attributeID: NIFGEN_ATTR_ANALOG_PATH

i value: NIFGEN_VAL_FIXED_LOW_GAIN_ANALOG_PATH
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Call niFgen_SetAttributevViInt32 to set the gain DAC value
(niFgen property node: Calibration»Gain DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_GAIN_DAC_VALUE

e value: 1700

Call niFgen_SetAttributeviInt32 to set the offset DAC value
(niFgen property node: Calibration»Offset DAC Value) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "0"

e attributeID: NTFGEN_ATTR_OFFSET_DAC_VALUE

e value: 32767

Call niFgen_SetAttributeViRealé64 to set the pre-amplifier
attenuation (niFgen property node: Calibration»Pre-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

¢ channelName: "0"

e attributeID: NIFGEN_ATTR_PRE_AMPLIFIER_ATTENUATION
e value: 0

Call niFgen_SetAttributeViRealé64 to set the post-amplifier
attenuation (niFgen property node: Calibration»Post-Amplifier
Attenuation) using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

¢ channelName: "0"

e attributeID: NIFGEN_ATTR_POST_AMPLIFIER_ATTENUATION
e value: 0

Call niFgen_SetAttributeViReal64 to set the output impedance
(niFgen property node: Basic Operation»>Output Impedance) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"
e attributelD: NIFGEN_ATTR_OUTPUT_IMPEDANCE

e value: 50
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9. CallniFgen_SetAttributeViBoolean to enable the analog output
(niFgen property node: Basic Operation»>QOutput Enabled) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
* channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_TRUE

10. Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
11. Wait 500 ms for the output to settle.

12. Call niFgen_SetAttributeviInt32 to set the calibration ADC
input (niFgen property node: Calibration»Cal ADC Input) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
* channelName: " (empty string)

e attributeID: NTFGEN_ATTR_CAL_ADC_INPUT

e value: NIFGEN_VAL_ANALOG_OUTPUT

13. Call niFgen_WriteBinaryl6AnalogStaticvValue (niFgen Write
Binary 16 Analog Static Value VI) to set the main DAC value using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
* channelName: "0"
e value: 27232

14. Call niFgen_SetAttributeViBoolean to disable the analog
output (niFgen property node: Basic Operation»QOutput Enabled)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_FALSE

15. Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal

16. Wait 500 ms for the output to settle.
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17.

18.

19.

20.
21.

22.

23.
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Call niFgen_ReadCalaDC (niFgen Read CAL ADC VI) to measure
the analog output voltage with the onboard calibration ADC using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ numberOfReadsToAverage: 3
¢ returnCalibratedValue: vI_FALSE

¢ calADCValue: A ViReal64 variable. The variable passed by
reference through this parameter receives the voltage measured
by the onboard ADC. This value is cal ADC measurement 0,
which is used in step 31.

Call niFgen_SetAttributeViBoolean to enable the analog output
(niFgen property node: Basic Operation»Output Enabled) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_TRUE

Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the NI 5412 voltage output directly into the
DMM into a high-impedance load. This measurement is external
measurement 0, which is used in step 31.

Call niFgen WriteBinaryl6AnalogStaticValue (niFgen Write
Binary 16 Analog Static Value VI) to set the main DAC value using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"
e value: 10232

Call niFgen_SetAttributeViBoolean to disable the analog
output (niFgen property node: Basic Operation»Output Enabled)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"
e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_FALSE
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24.

25.
26.

27.

28.

29.
30.

31.
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Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Call niFgen_ReadCalAaDC (niFgen Read CAL ADC VI) to measure
the analog output voltage with the onboard calibration ADC using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
*  numberOfReadsToAverage: 3
e returnCalibratedValue: vI_FALSE

* calADCValue: A ViReal64 variable. The variable passed by
reference through this parameter receives the voltage measured
by the onboard calibration ADC. This value is cal ADC
measurement 1, which is used in step 31.

CallniFgen_SetAttributeviBoolean to enable the analog output
(niFgen property node: Basic Operation»Output Enabled) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_TRUE

Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal
Wait 500 ms for the output to settle.

Use the DMM to measure the NI 5412 voltage output directly into the
DMM (into a high-impedance load). This measurement is external
measurement 1, which is used in step 31.

Call niFgen_CalAdjustcCalaDpc (niFgen Cal Adjust Cal ADC VI)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal

* voltagesMeasuredExternally: An array containing two
elements—the two voltages (external measurement O,
external measurement 1) thatyou measured with the
DMM in order

*  voltagesMeasuredWithCalADC: An array containing two
elements—the two voltages (cal ADC measurement 0,
cal ADC measurement 1)thatyou measured with the onboard
calibration ADC in the order that you measured them
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32. Call niFgen_SetAttributeViBoolean to disable the analog
output (niFgen property node: Basic Operation»QOutput Enabled)
using the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
¢ channelName: "0"

e attributeID: NIFGEN_ATTR_OUTPUT_ENABLED

e value: VI_FALSE

33. Call niFgen_SetAttributeviInt32 to set the calibration ADC
input (niFgen property node: Calibration»Cal ADC Input) using
the following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e channelName: "" (empty string)

e attributeID: NTFGEN_ATTR_CAIL_ADC_INPUT

e value: NIFGEN_VAL_GROUND

34. Call niFgen_Commit (niFgen Commit VI) to commit the attribute
values to the device using the following parameter:

e vi: The session handle returned from niFgen_InitExtCal

Closing the External Adjustment Session

When you have completed all the adjustment stages, you must close the
external adjustment session to store the new calibration constants in the
onboard EEPROM.

Call niFgen_CloseExtCal (niFgen Close Ext Cal VI) using the
following parameters:

e vi: The session handle returned from niFgen_InitExtCal
e action:

—  If the external adjustment procedure completed without any
errors, use NIFGEN_VAL_EXT_CAL_COMMIT. This function
stores the new calibration constants, updated calibration dates,
updated calibration temperatures in the onboard EEPROM.

—  If any errors occurred during the external adjustment
procedure, or if you want to abort the operation, use
NIFGEN_VAL_EXT_CAL_ABORT. This function discards
the new calibration constants and does not change any
of the calibration data stored in the onboard EEPROM.
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Calibration Utilities

NI-FGEN supports several calibration utilities that allow you to retrieve
information about adjustments performed on the NI 5412, restore an
external calibration, change the external calibration password, and store
small amounts of information in the onboard EEPROM. You can retrieve
some data using MAX or the FGEN SFP; however, you can retrieve all
the data using NI-FGEN.

MAX

To retrieve data using MAX, complete the following steps:

1.
2.

FGEN SFP

Launch MAX.

Select the device from which you want to retrieve information from
My System»Devices and Interfaces»NI-DAQmx Devices.

Select the Calibration Tab on the lower right corner.

You should see information about the last dates and temperature for
both external and self-calibration.

To retrieve data using the FGEN SFP, complete the following steps:

1.
2.
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Launch the FGEN SFP.

Select the device from which you want to retrieve information using
the Device Configuration dialog box (Edit»Device Configuration).

Open the Calibration dialog box (Utility»Calibration).

You should see information about the last dates of both external and
self-calibration.
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NI-FGEN provides a full complement of calibration utility functions and
VIs. Refer to the NI Signal Generators Help for the complete function
reference. The utility functions include:

niFgen_RestorelLastExtCalConstants
niFgen_GetSelfCalSupported
niFgen_GetSelfCallastDateAndTime
niFgen_GetExtCalLastDateAndTime
niFgen_GetSelfCallLastTemp
niFgen_GetExtCalLastTemp
niFgen_GetExtCalRecommendedInterval
niFgen_ChangeExtCalPassword
niFgen_SetCalUserDefinedInfo
niFgen_GetCalUserDefinedInfo

niFgen_GetCalUserDefinedInfoMaxSize
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Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the
Council of the European Communities using the manufacturer’s
declaration of conformity. This system affords the user protection for
electronic compatibility (EMC) and product safety. You can obtain the DoC
for your product by visiting ni.com/certification. If your product
supports calibration, you can obtain the calibration certificate for your
product at ni.com/calibration.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 0 662 45 79 90 0,
Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 6555 7838,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 385 09 725 725 11, France 33 0 1 48 14 24 24,
Germany 49 0 89 741 31 30, India 91 80 51190000,

Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970,
Korea 82 02 3451 3400, Lebanon 961 0 1 33 28 28,
Malaysia 1800 887710, Mexico 01 800 010 0793,
Netherlands 31 0 348 433 466, New Zealand 0800 553 322,
Norway 47 0 66 90 76 60, Poland 48 22 3390150,

Portugal 351 210 311 210, Russia 7 095 783 68 51,
Singapore 1800 226 5886, Slovenia 386 3 425 4200,

South Africa 27 0 11 805 8197, Spain 34 91 640 0085,
Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51,
Taiwan 886 02 2377 2222, Thailand 662 992 7519,

United Kingdom 44 0 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section onni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents. txt file on your CD, or
ni.com/patents.
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